
Experiment VP-2: Blood Pressure, Pulse, and Imposed Conditions

Background

When the heart pumps blood into the arteries, there is a sudden increase in pressure in the arteries. The 
highest level of pressure, that occurs immediately after the ventricles contract, is known as the systolic 
blood pressure. The pressure in the arteries slowly declines as the heart relaxes. The lowest level of 
pressure, that occurs just prior to the next contraction of the ventricles, is known as the diastolic blood 
pressure.

This lab will include a series of short-term experiments. Subjects will be engaged in a number of short-
term experiments to see the effects of apnea, exercise and temperature on blood pressure and peripheral
circulation.

Warning: As explained above, this procedure involves stopping blood flow to the arm, which 
is potentially dangerous. Please take the following precautions. 

Precautions

1. Know what you are doing ahead of time.

2. Do not leave the cuff inflated for any prolonged period of time (>20 seconds).

3. The subject should flex and extend their fingers between experiments to maintain blood flow.

4. This experiment should be performed by healthy individuals who do not have a personal or 
family history of cardiovascular or respiratory problems. It is preferable to use more than one 
subject during the course of the lab session.

Equipment Required

PC or Mac Computer

IX-ELVIS

USB cable

Power supply

PTN-104 Pulse plethysmograph

Stethoscope

BP-220 Non-invasive blood pressure transducer

A-BT-100 Tubing

GPSN-100 Pressure sensor
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IX-ELVIS Setup

1. Place the IX-ELVIS unit on the bench, close to the computer. 

2. Connect the IX-ELVIS to the computer with the supplied USB cable. 

3. Insert the power plug into the rear of the IX-ELVIS and plug the transformer into the electrical 
outlet. Turn on the power switches on the rear and on the upper right side of the top of the unit 
and confirm that the LEDs are illuminated.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 
not available, click on the Windows Start menu, move the cursor to All Programs and then to 
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 
will appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, ELVISNI.iwxgrp. Select this group and click 
Open.

4. Pull down the Settings menu again. Select the BP-Pulse-ImposedConditions-LS2 settings file.

5. After a short time, LabScribe will appear on the computer screen as configured by the PT-Pulse-
ImposedConditions-LS2 settings.

6. The settings used to configure the LabScribe software and the IX-ELVIS for this experiment are
programmed on the Preferences Dialog window which can be viewed by selecting Preferences 
from the Edit menu on the LabScribe Main window.

Blood Pressure and Pulse Transducers Setup

1. Locate the BP-220 non-invasive blood pressure transducer, the A-BT-100 tubing, and the GPSN
pressure sensor. Assemble them as illustrated in Figure VP-2-S1.

2. Locate the PTN-104 pulse plethysmograph (Figure VP-2-S2).

3. Plug the mini-DIN connector of the PTN-104 into the Channel 3 input of the IX-ELVIS (Figure 
VP-2-S3).

4. Plug the mini-DIN connector of the GPSN-100 pressure sensor into the Channel 4 input of the 
IX-ELVIS (Figure VP-2-S3). 
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Figure VP-2-S1: The BP-220 non-invasive blood pressure transducer, tubing, and GPSN-100 pressure 
sensor. 

Figure VP-2-S2: The PTN-104 pulse plethysmograph.
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Figure VP-2-S3: The PTN-104 pulse transducer and the BP-220 non-invasive blood pressure 
transducer connected to the IX-ELVIS.

Calibration of the Non-Invasive Blood Pressure Transducer

Procedure

1. With the supplied manometer in place, put the cuff of the BP-220 on the upper arm of the 
subject. Align the arrow on the cuff over the subject’s brachial artery. Have the subject sit and 
rest while the blood pressure sensor is calibrated.

2. Type Calibration @ 70 mmHg in the Mark box to the right of the Mark button. Inflate the 
pressure in the cuff to 70 mmHg as read on the manometer. 

3. Click on the Record button, located on the upper right side of the LabScribe Main window 
(Figure VP-2-L1). The signal should begin scrolling across the screen.

Note: If the user clicks the Record button and there is no communication between the IX-ELVIS 
and computer, an error window will appear in the center of the Main window. Make sure the 
IX-ELVIS is turned on and connected to the USB port of the computer. Click OK and select the 
Find Hardware function from the LabScribe Tools menu. 

4. Click on the AutoScale button at the upper margin of the Pulse and Blood Pressure channels. 
Your recording should look like Figure VP-2-L1. 
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• If the signal on the Pulse channel is upside down when compared to trace in Figure VP-2-L1,
click on the downward arrow to the left of the channel title and select the Invert function. 
The trace should now look similar to the one in the figure.

• If the pulse signal is small or noisy, adjust the tension on the strap holding the pulse 
plethysmograph to the finger.

5. While recording, press the Enter key on the keyboard to mark the pressure in the cuff on the 
data. Record the output of the BP-220 at 70 mmHg pressure for ten to fifteen seconds before 
increasing the pressure in the cuff (Figure VP-2-L1). While recording at a pressure of 70mmHg,
type Calibration @ 140 mmHg in the Mark box.

6. As the recording continues, increase the pressure in the cuff to 140 mmHg and press the Enter 
key on the keyboard. Hold the pressure in the cuff at this level for ten to fifteen seconds. Then, 
click the Stop button to halt the recording

7. After the last measurement, release all the pressure from the blood pressure cuff and remove the
manometer. The subject should continue to relax in the supine position as he or she flexes and 
extends the fingers on the cuffed arm to return of blood to the arm. 

8. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 
in which to save the file. Designate the file type as *.iwxdata. Click on the Save button to save 
the data file.

Units Conversion

1. Scroll to the beginning of the calibration data for the BP-220 non-invasive blood pressure 
transducer.

2. Use the Display Time icons to adjust the Display Time of the Main window to show the data 
collected at 70 and 140 mmHg on the Main window at the same time (Figure VP-2-L4). The 
required data can also be selected by:

• Placing the cursors on either side of data required

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the segment 
with the four selected pulse cycles to the width of the Main window.

3. Click the 2-Cursor icon (Figure VP-2-L2) so that two vertical cursors appear on the Main 
window. Place one cursor on the data collected when the pressure in the cuff was 70 mmHg and
the second cursor on the data collected when the pressure was 140 mmHg. 
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Figure VP-2-L1: The output of the BP-220 non-invasive blood pressure transducer displayed on the 
Main window with cursors at the points where the pressures in the cuff were 70 and 140 mmHg.

Figure VP-2-L2: The LabScribe toolbar.

4. To convert the voltages at the positions of the cursors to pressure values, use the Simple Units 
Conversion dialogue window (Figure VP-2-L3). To access this dialogue window, click on the 
arrow to the left of the channel title, Blood Pressure, to open the channel menu. Select Units 
from the channel menu, and select Simple from the Units submenu. 
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Figure VP-2-L3: The Simple Units Conversion dialogue window with the voltages at the cursors set to 
equal the pressures in the BP-220 non-invasive blood pressure transducer.

5. On the units conversion window, make sure 2 point calibration is selected in the pull-down 
menu in the upper-left corner of the window. Put a check mark in the box next to Apply units to 
all blocks. Notice that the voltages from the positions of the cursors are automatically entered 
into the value equations. Enter the two pressures used in the calibration recording in the 
corresponding boxes on the right side of the conversion equations. Enter the name of the units, 
mmHg, in box below the pressures. Click on the OK button in the lower right corner of the 
window to activate the units conversion.

Exercise 1: Measuring Blood Pressures

Aim: To determine the systolic and diastolic blood pressures in a reclining subject.

Procedure

1. Instruct the subject to rest in the supine position for at least five minutes before his or her blood 
pressure is taken.

2. While the subject is resting, place the blood pressure cuff around the upper portion of the left 
arm, just above the elbow. Place the PTN-104 pulse plethysmograph on the volar surface 
(where the fingerprints are located) of the distal segment of the left middle finger or thumb. 
Wrap the Velcro strap around the end of the finger to attach the unit firmly in place.

3. At the end of the rest period, click on the Record button to begin recording the subject’s pulse, 
blood pressure, and heart rate.
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4. Inflate the blood pressure cuff until the finger pulse wave on the Pulse channel disappears 
(Figure VP-2-L4).

5. Once the pulse wave disappears, release the cuff pressure at the rate of ~10 mmHg/second. 
Continue to release the pressure in the cuff until the aneuroid gauge reads 20 mmHg. 

6. Click the Stop button. 

7. The subject should continue to rest in the supine position between Exercises 1 and 2. To 
improve circulation in his or her arm, the subject should flex and extend their fingers to 
encourage blood circulation. 

8. Select Save in the File menu.

Data Analysis

1. Scroll through the recording and find the section of data recorded before, during, and after the 
blood pressure cuff was inflated (Figure VP-2-L4). 

Figure VP-2-L4: The pulse wave, the cuff pressure, and heart rate recorded before, during, and after 
the occlusion of the brachial artery. Pulses disappear as the pressure in the cuff exceeded the pressure 
in the artery. As the pressure in the cuff is released, the pulse wave reappears. 

2. Use the Display Time icons to adjust the Display Time of the Main window to show the pulse, 
cuff pressure, and heart rate from the time prior to the occlusion of the artery to the pressure in 
the cuff being 20 mmHg. This section of data can also be selected by:

• Placing the cursors on either side of the section of data needed, and;
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• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the segment 
of data to the width of the Main window.

3. Click on the Analysis window icon in the toolbar (Figure VP-2-L2) or select Analysis from the 
Windows menu to transfer the data displayed in the Main window to the Analysis window.

4. Look at the Function Table that is above the uppermost channel displayed in the Analysis 
window. The mathematical functions that are listed should include V2-V1, Value1, Value2, T2-
T1, and Mean. The values for these parameters from each channel are seen in the table across 
the top margin of each channel.

5. Once the cursors are placed in the correct positions for determining the blood pressures, the 
values for the blood pressures can be recorded in the on-line notebook of LabScribe by typing 
the names and values directly into the Journal.

6. The functions in the channel pull-down menus of the Analysis window can also be used to enter
the names and values of the parameters from the recording to the Journal. To use these 
functions:

• Place the cursors at the locations used to measure the cuff pressure on the Blood Pressure 
channel.

• Transfer the name of the mathematical function used to determine the blood pressure to the 
Journal using the Add Title to Journal function in the ECG Channel pull-down menu.

• Transfer the value for the blood pressure to the Journal using the Add Ch. Data to Journal 
function in the ECG Channel pull-down menu.

7. Once the cursors are placed in the correct positions for determining the systolic, diastolic, and 
pulse pressures, record the values for these pressures in the Journal using the one of the 
techniques described in Steps 5 or 6.

8. Use the mouse to click on and drag the cursors to specific points on the pulse and blood 
pressure recording to measure the following:

• Systolic blood pressure. To determine the subject’s systolic blood pressure, place a cursor on
the first of the smallest pulse waves that reappear after the pressure from the cuff of the BP-
220 is released. Value1 on the Blood Pressure channel is the systolic blood pressure. Enter 
this pressure in Table VP-2-L2.

• Diastolic blood pressure. To determine the subject’s diastolic blood pressure, place the other
cursor on the first of the largest pulse waves that reappear as the pressure from the cuff of 
the BP-220 is released. Value2 on the Blood Pressure channel is the diastolic blood pressure.
Enter this pressure in Table VP-2-L2.

• Pulse pressure, which is the difference between the systolic and diastolic pressures. To 
measure the pulse pressure, leave the cursors on the pulses that were placed at the systolic 
and diastolic pressures. The value for V2-V1 on the Blood Pressure channel is the pulse 
pressure. Enter this pressure in Table VP-2-L2.

• Heart rate. To measure the heart rate, place the cursors on either side of six adjacent pulses 
that occurred before the blood pressure cuff was inflated. The value for Mean on the Heart 
rate channel is the subject’s average heart rate. Enter the heart rate in Table VP-2-L2.
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9. Determine the subject’s blood pressure class from Table VP-2-L2. List the subject’s class in 
Table VP-2-L1.

Table VP-2-L1:Classification of Blood Pressure Levels According to the Seventh Report of the 
Joint National Committee on Prevention, Detection, Evaluation, and Treatment of High Blood 
Pressure (JNC 7).

Class Systolic Pressure (mmHg) Diastolic Pressure (mmHg)

Hypotensive less than 90  less than 60

Normal 120 and 80

Prehypertensive 120-139 or 80-89

Hypertensive Stage 1 140-159 or 90-99

Hypertensive Stage 2 greater than 160 or greater than 100

Table VP-2-L2: Blood Pressures and Heart Rates from Subjects in the Class.

Subject
HR
(BPM)

Systolic Pressure 
(mmHg)

Diastolic Pressure 
(mmHg)

Pulse Pressure 
(mmHg)

BP Class
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Exercise 2: Effects of Exercise 

Aim: To examine the effects of exercise on blood pressure.

Procedure

1. Select a new subject and instruct the subject to sit and relax for at least five minutes before his 
or her blood pressure is taken.

2. Place the blood pressure cuff of the BP-220 around the upper portion of the left arm, just above 
the elbow. Place the PTN-104 pulse plethysmograph on the volar surface of the distal segment 
of the left middle finger. Wrap the Velcro strap around the end of the finger to attach the unit 
firmly.

3. Use the same procedures outlined in Exercise 1 to record the subject’s blood pressures from his 
or her upper left arm.

4. After recording the subject’s resting blood pressure, remove the blood pressure cuff and pulse 
plethysmograph from the subject. Leave these devices connected to the iWorx 214.

5. Instruct the subject to exercise vigorously enough to elevate his or her heart rate. Walking up 
and down stairs or doing jumping jacks are suitable exercises.

6. While the subject is exercising, type “Recovery from Exercise” in the Mark box to the right of 
the Mark button.

7. Immediately after exercising, the subject should sit in a chair. Other members of the group 
should attach the pulse plethysmograph and blood pressure cuff to the subject as done in Step 2.

8. Click on the Record button, inflate the cuff and record the data needed to determine the 
subject’s blood pressure immediately after exercise. Press the Enter key on the keyboard as the 
subject’s blood pressure is recorded. After the data needed to determine the subject’s blood 
pressure is recorded:

• Deflate the blood pressure completely.

• Monitor the subject’s heart rate by continuing to record.

9. Every thirty seconds after the beginning of the recovery period, pump up the blood pressure 
cuff and record the subject’s blood pressure. Continue to record the subject’s blood pressure 
until the pressures are similar to the resting pressures.

10. Click Stop to halt recording.

11. Select Save from the File menu.

Data Analysis

1. Use the same techniques used in Exercise 1 to determine and record the systolic, diastolic, and 
pulse pressures and heart rates of the subject at all the time intervals throughout the exercise and
recovery experiment.

2. Enter the subject’s blood pressures and heart rates at each time interval in Table VP-2-L3.

Vascular Physiology-BP-Pulse-ImposedConditions VP-2-11

file:///Users/stephenhauptman/Desktop/IFHPLMv2/BP-Pulse-ImposedConditions-F-LS2.htm#Rai87074


Table VP-2-L3: The Effect of Aerobic Exercise on Blood Pressure and Heart Rate

Type of Exercise
_____________ Heart

Rate
(BPM)

Systolic Pressure
(mmHg)

Diastolic Pressure
(mmHg)

Pulse
Pressure
(mmHg)Time

(secs)

0

30

60

90

120

150

180

210

240

270

Questions

1. Compare the blood pressures before and after exercise. How long does it take your subject’s 
blood pressure to return to the resting level? How does the time it takes your subject’s blood 
pressure to return to normal compare to the times of other subjects?

2. Compare the heart rates before and after exercise. How long does it take your subject’s heart 
rate to return to the resting level? How does your subject’s recovery time compare to those of 
other subjects.
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Exercise 3: Effects of Apnea

Aim: To examine the effects of apnea (holding one’s breath) on blood pressure.

Procedure

1. Use the same methods used in Exercise 1 to record the subject’s resting blood pressures from 
the upper left arm.

2. Instruct the subject to take a deep breath, hold it for as long as possible, and then return to 
breathing normally. While the subject is holding his or breath, use the same methods used in 
other exercises to record the subject’s blood pressures.

3. As soon as the subject stops holding his or her breath, record the subject’s blood pressures and 
heart rate.

4. Record the subject’s blood pressure and heart rate every 30 seconds after the subject stops 
holding his or her breath.

5. Select Save in the File menu.

Data Analysis

1. Use the same techniques used in Exercise 1 to determine the systolic, diastolic, and pulse 
pressures of the subject at all the time intervals throughout the long-term experiment.

2. Enter the subject’s blood pressures and heart rates at each time interval in Table VP-2-L4.

Table VP-2-4: The Effect of Apnea on Blood Pressure and Heart Rate

Apnea
Heart
Rate

(BPM)

Systolic
Pressure (mmHg)

Diastolic Pressure
(mmHg)

Pulse
Pressure
(mmHg)Time

(secs)

0

30

60

90

120

150
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Questions

1. What effect does apnea have on the subject’s blood pressure? 

2. How does the subject’s blood pressure change when the subject resumes breathing after apnea?

3. What are the physiological causes of the changes you see in the blood pressure and heart rate

Exercise 4: Effects of Cooling the Forearm

Aim: To measure the effects of cold temperatures on the pulse amplitude and blood pressure.

Procedure

1. Use the same methods used in other exercises to record blood pressures from the subject’s right 
forearm. Mark the recording with comments to indicate the subject’s name, the location of the 
blood pressure cuff, and the temperature of the room.

2. After the blood pressures from the subject’s right forearm are recorded, remove the blood 
pressure cuff from the arm. Leave the pulse plethysmograph attached to the subject’s finger to 
monitor any changes in the subject’s pulse amplitude.

3. Type “Ice Pack On” in the Mark box to the right of the Mark button. Place an ice pack on the 
ventral side (inside) of the subject’s right forearm. Put a couple of paper towels between the ice 
pack and the subject’s arm. Remind the subject to remain motionless during the recordings. 

4. As soon as the ice pack is in place, click on the Record button. Press the Enter key on the 
keyboard to mark the recording. Record the subject’s pulse for about 10 seconds. Click on the 
Stop button.

5. At every minute into the ten-minute cooling period, record the subject’s pulse for about 10 
seconds as it was done in Step 5.

6. Before the end of the ten-minute cooling period, type “Ice Pack Removed” in the Mark box. Be 
ready to wrap the blood pressure cuff around the subject’s right forearm as soon as the ice pack 
is removed.

7. At the end of the ten-minute cooling period, remove the ice pack from the subject’s arm, and 
wrap the blood pressure cuff around the subject’s right forearm as quickly as possible.

8. Click on the Record button and press the Enter key on the keyboard. Use the same methods 
used earlier to record and identify the blood pressures from the subject’s right forearm.

9. At every minute after the end of the cooling period, record and identify the subject’s blood 
pressures. Record every minute for five minutes.

10. Select Save in the File menu.

Data Analysis

1. Use the same techniques used in Exercise 1 to determine and record the systolic, diastolic, and 
pulse pressures and heart rates of the subject before and after the cooling period.

2. Measure the amplitudes of the pulses prior to the cooling period, during cooling at one-minute 
intervals, and after cooling at one-minute intervals:
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• Scroll through the recording and find the section of data recorded at the beginning of the 
cooling period. 

• Use the Display Time or Zoom between Cursors functions to adjust the Display Time of the 
Main window to show the first ten seconds of the pulse and heart rate at the beginning of 
cooling period.

• Click on the Analysis window icon in the toolbar (Figure VP-2-L2) or select Analysis from 
the Windows menu to transfer the data displayed in the Main window to the Analysis 
window (Figure VP-2-L5).

• Measure the pulse amplitude by placing one cursor at the beginning of the pulse wave and 
the other cursor at the peak of the pulse wave. The value for V2-V1 on the Pulse channel is 
the pulse amplitude. Use one of the two techniques described earlier to record this pulse 
amplitude in the Journal.

• Measure the amplitudes of two additional pulse waves adjacent to the first pulse wave 
measured. Enter these values in the Journal.

• Calculate the average of these three pulse amplitudes at this time interval. Record this mean 
in the Journal.

• Use the same methods to calculate and record the mean pulse amplitudes at the other time 
intervals in the cooling period.

Figure VP-2-L5: Pulses recorded during an early section of the cooling period displayed in the 
Analysis window. The cursors are in position to record the pulse amplitude.
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3. Enter the subject’s blood pressures, heart rates, and mean pulse amplitudes at each time interval 
in Table VP-2-L5.

Questions

1. By examining the pulse data during the cooling period, determine if cooling has any effect on 
pulse amplitude? Explain your conclusion.

2. Determine if cooling has any effect on heart? Explain your conclusion.

3. Determine if cooling has any effect on blood pressure? Explain your conclusion.

Exercise 5: Effects of Warming the Forearm

Aim: To examine the effects of warming the forearm on blood pressure, heart rate and 
peripheral circulation.

Warning: It is very important to use a different subject from Exercise 4 due to the rapid 
warming and change in temperature of the forearm. Do not warm the forearm to more than 
110 degrees Fahrenheit.

Procedure

Use the same methods used in Exercise 4 to test the effects of warming the forearm of a new subject.

Data Analysis

1. Use the same methods used in Exercise 4 to analyze the data recorded in Exercise 5. Record the
results in Table VP-2-L6.

Questions

1. By examining the pulse data during the warming period, determine if warming has any effect on
pulse amplitude. Explain your conclusion.

2. Determine if warming has any effect on heart. Explain your conclusion.

3. Determine if warming has any effect on blood pressure. Explain your conclusion.
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Table VP-2-L5: The Effects of Cooling on Blood Pressure, Heart Rate, and Pulse Amplitude.

Cooling
Time

(Mins)

Heart
Rate

(BPM)

Systolic
Pressure (mmHg)

Diastolic Pressure
(mmHg)

Pulse Pressure
(mmHg)

Pulse
Amplitude

(V)

Prior

0

1

2

3

4

5

6

7

8

9

10

After

1

2

3

4

5
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Table VP-2-L7: The Effects of Warming on Blood Pressure, Heart Rate, and Pulse Amplitude.

Warming
Time

(Mins)

Heart
Rate

(BPM)

Systolic
Pressure (mmHg)

Diastolic Pressure
(mmHg)

Pulse Pressure
(mmHg)

Pulse
Amplitude

(V)

Prior

0

1

2

3

4

5

6

7

8

9

10

After

1

2

3

4

5
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